Chapter 1
Own the Printing Press

In This Chapter
Deciding when to use Microsoft Publisher 2007
Understanding desktop publishing
Exploring the design process

Using Publisher templates

Desktop publishing uses page layout software and a personal computer
to combine text, type, drawings, and images on a page to create books,
newsletters, marketing brochures, flyers, greeting cards, and Web sites, for
example. Anything you can print on a page can be put into a page layout pro-
gram. Microsoft Publisher 2007 lets you place elements on a page, precisely
position them, modify them, and specify a print job by using techniques that
commercial printers require. Whether you print to your inkjet or laser printer,
run down the street to Quick Copy Shop, or send your files to a commercial
printer, Microsoft Publisher 2007 helps you prepare your work for that level
of quality:.

When Should Vou Use Microsoft
Publisher 2007?

Many programs let you design and print pages to various levels of sophistica-
tion. These programs include word processors such as Microsoft Word 2007
and Corel WordPerfect Office X3; graphics programs such as CorelDRAW and
Adobe Illustrator; and even low-end integrated packages such as Microsoft
Works and Broderbund ThinkFree Office 3. The program I use for writing,
Microsoft Word 2007, enables me to type text, format text, import pictures,
create drawings, and even work with images.

If you can do all that in Microsoft Word 2007, why do you need a desktop
publishing or page layout program like Microsoft Publisher 2007? The short
answer is control. Microsoft Publisher 2007 lets you control these elements
with finer precision and also offers you many special tools.
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What's new in Microsoft Publisher 2007?

If you've used a previous version of Microsoft .~ Publisher Tasks: The new Publisher Tasks

Publisher you may be wondering why you should pane in Microsoft Publisher 2007 provides
bother with this latest version. Well, here is a par- help with common publication creation and
tial list of new features to be found in Microsoft distribution procedures.

FUbllstiir 21 v Reuse design elements: The Content Library

v~ Apply your brand in one step: Microsoft lets you store and reuse text, graphics, and
Publisher 2007 lets you easily apply and view other design elements in any of your Microsoft
logos, colors, fonts, and other information in Publisher publications.
one step. »* Publish in PDF or XPS format: Download a
v~ Search templates: It's easier than ever to find free add-in and you can save your Microsoft
templates within Microsoft Publisher 2007, and Publisher 2007 files in PDF or XPS format.

now you can even preview templates online.
Just point your Web browser to the Microsoft
Office Online Web site to access hundreds of
Microsoft Publisher templates — without ever
having to leave Microsoft Publisher 2007!

v~ Create a new marketing campaign: If you have
Microsoft Outlook 2007 with Business Contact
Manager, you can create and track your own
marketing campaigns!

So, if you just want to stick your company’s logo at the top of your letters
and insert a copy of your scanned-in signature at the bottom, you don’t need
Publisher to do that. If you want to create a company logo by combining a
couple of graphics from different sources, write some text, add some color,
and then separate the output to give to a commercial print service to print,
Publisher is a better choice. If you want to create high-quality marketing
materials that will help you attract new customers and keep existing cus-
tomers, Publisher is definitely the way to go. It does these things well.

How Desktop Publishing Works

Page layout software combines various parts into a single document, or publi-
cation. The following list briefly covers the parts you can meld. In Figure 1-1,
you can see that I labeled a few sample elements.

Nearly all objects on a page are in frames or blocks that are created when
you import or create the object:

v Text: Okay, | know that you know what text is. Text is the stuff you type: all
those individual characters that form words, sentences, and paragraphs,
for example.
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|
Figure 1-1:
A sample
publication
with labeled
objects.
|

v Type: Man/woman does not live by text alone. Type and typography are
the various letter forms you can use to make your text more attractive.
Publisher lets you access WordArt, a text manipulation program that lets
you add fancy effects to your text.

v+ Picture: Computers make two kinds of pictures: drawn (vector, or object-
oriented) and painted (raster, or bitmapped) images. You can import both
types into a picture frame.

While Publisher doesn’t ship with a ton of clip art, you can go to the
Microsoft Office Web site to access a huge amount of clip art, including
thousands of clip art images, photographs, Web-related graphics, ani-
mated GIFs (those cute pictures that seem to wiggle around on Web
pages), and more! In fact the Microsoft Office Web site has more than
150,000 free images and sounds. Check it out at http://office.
microsoft.com/clipart.

v Drawn object: Publisher isn’t a drawing program, although some tools on
its Objects toolbar enable you to create drawn images, such as lines, ovals
and circles, rectangles and squares, and a whole bunch of custom shapes.

v Table: Although you can import tables from other programs as objects, as
either drawings or Object Linking and Embedding (OLE) objects managed
by other applications, Publisher has its own Table tool.
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Figure 1-2:
The
Microsoft
Publisher
2007 screen.
|

You can use Publisher to create these elements from scratch, or you can use
other programs to create the objects and then use Publisher to place them in
your publication.

If you have used a previous version of Publisher or Microsoft Office, most
things you see on the screen will seem familiar. However, if your first exposure
to Publisher and/or Office is with version 2007, you might need a brief tour.
The first thing you’ll probably notice is that the user interface in Microsoft
Publisher 2007 is quite a bit different from the rest of the Microsoft Office 2007
products. Microsoft Publisher 2007 utilizes the more traditional menu system
found in Microsoft Office 2003 and earlier. The “other” Microsoft Office prod-
ucts use Microsoft’s new Ribbon interface that is intended to make it easier
and faster to find the commands and features when you need them.

Let’s take a moment to get familiar with the Microsoft Publisher 2007 screen.
Figure 1-2 shows you Publisher with an open publication. If you look closely,
you’ll find the following:

v Title bar: At the very top of the Publisher window, you’ll find the Title
bar. The Title bar shows you the name of the current publication and
whether the publication is a Print Publication or a Web Publication.

* Menu bar: Just below the Title bar you'll find the Menu bar. The Menu
bar contains, (yes, you guessed it!) the menus. The Menu bar gives you
access to all the features and functions of Publisher. Everything from
creating publications to specifying program settings to getting help.

=L |
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v~ Standard toolbar: This toolbar is located right below the Menu bar. The
Standard toolbar’s main job is to let you control the appearance of the
text in your publication.

v Publisher Tasks pane: This little guy likes to hang out on the left side
of the screen just under the Standard toolbar. Although often hidden, it
expands to provide links that guide you through the steps necessary to
complete the design of your publication.

+” Objects toolbar: This toolbar is located on the left side of the screen. It
has the tools to help you create Text boxes, Tables, Pictures, and the like.

v Publication workspace: In the middle of the screen you’ll see a large
white box. The shape of this box varies with the type of publication you
are creating. This white box represents the page upon which you create
your publication.

+* Rulers: The rulers located above and to the left of the publication work-
space are provided to help you lay out and properly align objects on
your page.

v Scroll bars: On the right and bottom of the screens you see scroll bars
that let you scroll vertically and horizontally when your entire document
doesn’t fit on the screen.

1 Page Selection bar: The Page Selection bar, located at the bottom left of
the screen, lets you quickly go to any page in your publication. This may
not seem like a big deal in a one-page flyer, but if you are working on a
300-page catalog, that feature comes in mighty handy.

The Design Process

Page design is an iterative process. You can always find a better way to make

a point with design, to use type and color, or to refine a graphical image, for
example. You can always return to a publication later and find something you
could have done better. Like all creative endeavors, a well-designed publication
can be improved by planning before the fact, experimenting, and offering
thoughtful criticism at all stages. The sections that follow describe some
methods that designers use to make their pages stand out from the crowd.

Storyboarding

To get a good start on the design process, you can block out the way you want
your publication to look. One block-out method is storyboarding. Storyboards

15
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are like block diagrams. Cartoonists use storyboards to show a story’s pro-
gression. Movie designers use storyboards to illustrate key frames in a movie,
which enables them to present the movie in a preproduction form that others
can view and understand. You can use this same technique.

Many people like to mock up their design projects with pencil and paper.
They create a dummy of their publication and, when the publication spans
several pages, create storyboards. But this is all a matter of preference: The
important thing is to plan your publication before you create it.

[ find Publisher so easy to work with that I prefer to create my dummies inside
the program. The tools for creating frames, lines, and boxes make these page
elements easy to create and modify inside Publisher. I also find that working
inside the program forces me to think, right from the start, about how I'll break
apart a sample design and implement it.

Publisher has a collection of templates that help you create professional-
looking publications. When you first launch Publisher, you see the templates
in the Catalog window as a collection of thumbnails showing sample docu-
ments you can create. The Publication Types pane on the left provides a list
of the various types of publications that you can create with Publisher, while
the center pane shows a list of the most popular types of publications. When
you click on a type of publication in the Publication Types pane, the center
pane changes to show a list of thumbnail images that show you what the vari-
ous publications of that particular type will look like. (In other words, the list
of available templates changes with the type of publication you choose in the
Publication Types pane.)

In effect, storyboarding is what the templates do when they create a publica-
tion for you. When you create a document by using the Publisher templates,
the result is a dummy of the document you're creating. Figure 1-3 shows a four-
panel brochure created with one of the Brochures templates. The template
helps generate a sample document with a headline, graphics blocks, and text
frames with sample text. Each element on the page can be modified, but the
document’s overall look comes from using a particular Publisher template.
Your dummies, or mock-ups, should show similar use of text, graphics, and
overall design.

Try moving away from your design and looking at it from afar. (This trick works
well for many people.) Better yet, try zooming out so that you can see the over-
all layout but cannot read the text. Choose Viewr>Zoom from the main menu
and choose 33% or 25% from the submenu that appears. Determine whether its
purpose is obvious or whether clutter is obscuring its purpose. If you have too
many page elements, try eliminating some.
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Assembling a page

After you block out a page design, you can replace the dummy text, pictures,
and other frames with the data you want to include on the page. This is

the assembly stage of page composition. Depending on the type of object
frame (Publisher-speak for a text box or picture frame) or tool selected, you
can apply one of the Edit or Insert menu commands to bring the data into
Publisher. The basics of importing text are covered in Chapter 6. You can
find the related topic of importing tabular data also in Chapter 6. For details
on bringing graphics into your publication, see Chapter 10.

Chances are great that after you compose and fill all the frames with real data,
the page will require more tweaking. Publisher contains a number of special-
ized tools for repositioning, resizing, and fitting objects on a page. Chapter 12
details the final steps in the assembly process. You also find information about
preparing a publication for output to an outside printer in Chapter 13.

SN Don’t be surprised if the assembly process is largely composed of the tweak-
N ing phase of the project. Leave enough time to get this tweaking done the way
you want it. (Think of the builder who says that the house is 90 percent done
“ when only 50 percent of the allotted time is spent.)
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Printing a page

After your page is composed the way you want it, you're ready to print. You can
choose to print files to local printers and select from any of the print drivers
that came with Windows XP or Windows Vista. Printing to a local printer is no
different in Publisher than it is in most other Windows applications: You simply
choose Filew>Print.

If you intend to have your publication printed by a commercial printer, you
will probably want to send the entire Publisher file to the printer. The printer
then has the most flexibility to print your publication correctly. If your com-
mercial printer doesn’t have Publisher, you can send your publication as

a PDF file. The commercial printer can then extract and modify images but
cannot make many other types of changes or corrections. See Chapter 13

for details on having close encounters with printers of the third kind (human
ones, that is).

Getting Out of the Gate with Publisher

You start Microsoft Publisher 2007 in one of two ways:

v Double-click the icon for the program on the Windows desktop.

v Choose Start>Programs=>Microsoft Officec>Microsoft Office Publisher
2007, as shown in Figure 1-4. (Easy!)

Whichever way you start Publisher, you're greeted by the handy Catalog
window you see in Figure 1-5. Your first glimpse of the Catalog window shows
templates for the most popular publication types — business cards, brochures,
and postcards, for example — but you can change the view by choosing other
categories from the Publication Types pane, on the left. (Anyone for paper
folding projects?)

< If you're familiar with earlier versions of Microsoft Publisher, you may be

wondering what happened to its wizards. They have been replaced by

Publisher templates and the new Publisher Tasks pane.

Using a Publisher template is the easiest way to create a publication in
Microsoft Publisher 2007. After you select a publication type and choose

a template from the Catalog window, the Publisher Tasks pane appears, pre-
senting you with a set of dialog boxes that leads you through the creation
of a project based on selections you make.
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Figure 1-4:
Opening
Microsoft
Publisher
2007 from
the Start
menu.
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Figure 1-5:
Microsoft
Publisher
provides
hundreds of
templates in
more than
two dozen
publication
types.
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If for some reason Publisher is already open and you’re working somewhere
else in the program, you can always return to the Catalog window by choosing
File>New from the main menu.

The Catalog window is a modal dialog box, which means that you need
to make a selection in it or dismiss it before you can go on. You can click
and drag the Catalog window’s title bar as you would drag any window’s
title bar.

[ just made the assertion that using a Publisher template is the easiest way
to create a publication in Microsoft Publisher. The next section is meant to
show you just how right I am.

Just the fax, ma’am: Creating a fax cover

sheet the quick and easy way

Microsoft Publisher 2007 has hundreds of templates for more than 25 types
of publications; if you look back at Figure 1-5, you can see the (rather long)
list of available publication types. Some of the more useful publications are
in the Business Forms category, where you can find

v Expense reports

v Fax covers

v Inventory lists

v Invoices

v Purchase orders

v Quotes

v Refunds

1 Statements

v Time billings

v Weekly records

The Fax Cover publication type provides a quick example of how to use a
Publisher template to quickly create a useful business publication:

1. In the Publication Types pane (the listing on the left side of the
Catalog window), click the Business Forms link.
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The center pane of the Catalog window updates to show the available
Business Forms categories.

2. Scroll down to the Fax Cover section and then select one of the 35
Fax Cover examples.

The selected Fax Cover sheet is highlighted, and a larger sample version
appears in the top-right portion of the screen.

3. Click the Create button located in the bottom-right portion of
the screen.

Publisher creates (surprising, huh?) the Fax Cover for you and presents
you with the Publisher Tasks pane visible to the right of the publication,
as shown in Figure 1-6.

The Publisher Tasks pane stands ready to help you customize the publication.
Its main features include the ones in this list:

+* The Page Options tab: This tab is a bit of a chameleon. It changes depend-
ing on the type of publication you are working on. If you are working on a
Fax Cover sheet, it might display a business logo that you can click and
drag onto your publication. If you are working on a newsletter, it shows a
Columns section that lets you change the layout of your publication by
changing the number of columns.

v The Options tab: From this tab, you can quickly and easily select a differ-
ent template to use and also change the paper size. (The name of this
tab changes depending on whichever category you chose; in Figure 1-6,
it appears as the Business Form Options tab because I chose the Business
Form category.)

v+ The Font Schemes tab: Change the font scheme for the entire publication.
Font schemes are collections of fonts that were created by armies of highly
paid design consultants to be pleasing to the eye (the fonts, not the con-
sultants). Selecting a font scheme instantly applies the new fonts to your
publication. Of course, you have the option of creating your very own font
scheme, too. Who's to say that Old English Text MT and Bauhaus 93 don’t
go well together?

+* The Color Schemes tab: On this tab, you can change the — you guessed
it — color scheme. Just don’t go thinking that the same group of highly
paid consultants who created the font schemes also created the color
schemes. We're talking specialists here. As with the font schemes, you
also have the option of creating your own color scheme. Of course,
unless you and the person to whom you’re sending the fax have one
of those newfangled color fax machines, you're probably wasting your
time customizing the color scheme on your fax cover.
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Fun facts about Publisher templates
and the Publisher Tasks pane

You need to know few important points about the Publisher templates and
the Publisher Tasks pane; these tools are used to create new on-screen
publications inside Publisher:

+* The Print Preview feature lets you see how your document will look
when it is printed. Print Preview shows you your publication without
cluttering the screen with all those toolbars, menus, rulers, task panes,
etc. It even lets you view multiple pages at once (click the Multiple pages
button) or how the publication will look if printed on a monochrome
printer (click the Color/Grayscale button). Figure 1-7 shows the fax cover
through the “eyes” of Print Preview.

v~ Publications created with Publisher templates are composed of many
individual objects. If you click any part of a publication, selection handles
(little circles on the edges; see Figure 1-8) appear around the selected
area. With the help of these little guys, you can manipulate the size,
placement, color, and other properties of your publication’s parts.

v As handy as templates are, if you’re using templates only to create
documents in Publisher, you’re just scratching the surface of what you
can do with the program. I'm more than happy to present what’s under
the surface as you read through this book.
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Meet the publication types

Each publication type can generate several versions of publications of
the same class, depending on the selections you make. Publisher has 27
publication types (28 if you count the Blank Page Sizes selection):

1 Blank Page Sizes: Use these templates when you want to create a publi-
cation from scratch. You can choose the page size you want without
Publisher adding any sample pictures or text. You start with a clean slate.

v Advertisements: Use these templates to create advertisements for your
business. Figure 1-9 shows you the style affectionately referred to as
The Works.

1 Award Certificates: Choose from 22 different award certificates.

v+ Banners: This publication type offers eight types of banners:
Informational, Sale, Event, Welcome, Congratulations, Holiday, Romance,
and Get Well. You can set a height and width, and you can also decide
whether you want to have graphics and borders on your banner.

v Brochures: Four different brochure styles are offered: Informational,
Price List, Event, and Fund-raiser. Figure 1-10 shows previews of some
Informational brochures.

v+~ Business Cards: Choose from more than 50 styles of business cards.

+~ Business Forms: You have ten choices: Expense Report, Fax Cover,
Inventory List, Invoice, Purchase Order, Quote, Refund, Statement, Time
Billing, and Weekly Record. As you click each type of business form in the
Publication Types pane, a picture of the default form appears on the right
side of the screen. Figure 1-11 shows you an Invoice form that uses the
Eclipse style.

v Calendars: Choose from 46 full-page and 3 wallet-size calendars.
1~ Catalogs: Create ten different kinds of catalogs to advertise your wares.

v E-mail: Use any of these ten e-mail templates to create targeted e-mail
marketing campaigns.

v+ Envelopes: The Envelopes templates create more than 50 envelope
styles that match the Letterheads and Business Cards styles. Publisher
remembers the style you used and asks whether you want to base your
next envelope on that style.

v Flyers: This publication type includes styles for Informational, Special
Offer, Sale, Event, Fund-raiser, and Announcement.

v Gift Certificates: Forge — er, | mean, create — your own gift certificates!
Choose from 35 gift certificate styles.
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v Greeting Cards: Tired of paying $5 for a greeting card? You'll love this

publication type. It offers 20 categories of cards. Each of these cate-
gories offers you many choices. Figure 1-12 shows you an example of
a professional-looking thank-you card that you can create and send to
your clients.

+ Import Word Documents: These templates let you gussy up text you

created in Microsoft Word 2007. Select from 36 different styles. This

is a great tool if you have a Microsoft Word document that you want to
update so that it has the look and feel of other publications you have
created in Publisher. Have a report that you created in Microsoft Word
and you want it to look like that brochure you worked so hard to create?
Use the Import Word Documents templates.

v Invitation Cards: Having a to-do? These templates help you create invi-

tation cards for your party, theme party, holiday party, birthday party,
housewarming, shower, event, celebration, or fund-raiser.

v~ Labels: You can create labels in any of the following 11 styles: Mailing

Address, Shipping, Return Address, Computer Disk, Cassette, CD/DVD,
Video, Jar/Product, Binder, Bookplate, and Identification. All these labels
match standard Avery labels. The Avery number is provided after the
label name.
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Figure 1-12:
A thank-you
card
created with
the Layers
Greeting
Card
template.
|
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v Letterhead: The Letterhead templates offer you more than 50 styles of
letterhead that you can print. Figure 1-13 shows an example of a letter-
head using the Modular style. After you create a letterhead for your
business or personal use, Publisher remembers the style you used and
asks whether you want to base your next letterhead on that style.

v Menus: If you have your own restaurant, the Menus templates let you
create Regular, Take-Out, Daily Special, and Wine/Dessert menus in a
variety of styles.

1 Newsletters: Create almost 70 different styles of newsletters in a variety
of sizes and layouts.

1 Paper Folding Projects: Build your own paper tiger air force! Afraid to
fly? Create origami (the Japanese art of creating paper figures). The four
types range from easy to create (the Boat) to difficult (the Parrot). Still,
these items are fun to give, and they’re pretty when printed from a color
printer or on colored paper.

v Postcards: These templates create 13 categories of postcards:
Informational, Special Offer, Sale, Event, Invitation, Holiday Party
Invitation, Holiday Greeting, Holiday Thank You, Thank You, We've
Moved, Announcement, Reminder, and Tent Fold. Each category offers
several types of postcards.
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Figure 1-13:
A sample
Letterhead
style.

Part I: Getting Acquainted with Publisher 2007

v Programs: Create Music, Religious Service, and Theater programs with
a few clicks of the mouse.

+* Quick Publications: Use these templates when you want to create single-
page publications with a professional design and layout.

+* Resumes: Choose from Entry Level, Chronological, or Curriculum Vitae
résumés with style!

v~ Signs: Create 40 single-page signs — everything from Authorized
Personnel Only to Lemonade for Sale to Wheelchair Access.

1 Web Sites: Use these templates to create over 70 different multiple-page
Web sites quickly and easily.

v+ With Compliments Cards: Choose from 35 styles of With Compliments
cards. The cards come in handy when you have product samples and
freebies to give away and you want to make sure that the recipient knows
where they came from. Figure 1-14 shows a With Compliments card in the
Marquee style.

You aren’t limited to accepting whatever the templates give you. You can
replace one font with another, one picture with another, or one border with
another, for example. And, you can always use the Publisher Tasks pane to
make changes to the design of your publication. If the Publisher Tasks pane is
not visible, click the Publisher Tasks button on the Publisher Tasks toolbar to
display it. Knowing Publisher well helps you quickly modify these templates’
output and makes the result a document that you’re proud to show to others.
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|
Figure 1-14:
With
Compliments
card in the
Marquee
style.
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Create your own templates

If the hundreds of templates the preceding section introduces aren’t enough
for you, don’t despair. You can always create templates of your very own.
How do you perform such feats of wonder, you ask? Okay, maybe you didn’t
ask, but this stuff is handy, and I tell you how anyway. If you really don’t want
to know, please press the Pause button — now!

To create a template of your own, follow these steps:

1.

Start by creating a publication.

You can create one from scratch or start with an existing template and
customize it to your tastes.

. Choose File>Save As from the main menu.

The Save As dialog box appears, as shown in Figure 1-15.

3. Type a name for your new template in the File Name text box.

4. In the Save As Type drop-down list box, select Publisher Template

(*.pub).
Notice that Publisher automatically changes the Save In location to the
Templates folder.

. Click Save.
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Your template is now available for use. Click the My Templates link — right
there in the upper-left corner of the Catalog window — to see the list of
templates you've created. Figure 1-16 shows the My Templates pane with
two templates I created.
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